Volume II
Issue 4

“As a business owner, I know
you don’t have time to waste on
technical and operational issues.
That’s where we shine! Call us
and put an end to your IT
problems finally and forever!”
Bryan Lachapelle, President
B4 Networks Inc.
706 East Main ST,
Welland, Ontario, L3B 3Y4
Tel: 905.346.4966

www.b4networks.ca

I’m often asked about the ROI (return on
investment) for technology. Truth is, I don’t
believe you “invest” in technology.
Investments are things that provide a
measurable, quantifiable return for your
money.

new tires and oil changes to get an accurate
look at what you’ll pay. Therefore, the total
COST of owning a car is far more than just
the price tag – and a cheaper car up front can
end up costing more in the long-haul if
frequent repairs are needed.

Of course it can easily be
argued that technology does
provide a return for your money.
If you don’t think so, try
communicating with your
clients and market without email or tracking inventory with
pen and paper. And the right
technology applied with a smart
strategy can certainly give any
business owner a strategic advantage in faster
delivery of goods and services to customers,
greater productivity, lowered production costs
and the like. In fact, there aren’t too many
businesses that can operate without a few core
IT applications. But the reality is that your
bank account is going to be a bit lighter after
you install that new upgrade or technology, so
how do you know if that IT upgrade or project
is worth the money?

In IT, the same principle
applies. You have to look at
the TOTAL cost of a particular
IT decision, not just the price
tag, when comparing options.
For example, the real cost of
not upgrading a network may
actually be higher than
spending several thousand
dollars on new equipment and
upgrades when you accurately assess the total
cost of maintenance, service fees and poor
performance. These days, many business
owners are looking at “going to the cloud”
because they want to save money. And in
many cases, it will do just that, but the cost
savings will often come in the form of
cheaper devices, less maintenance and low (or
no) upgrade costs over a 3 year period – not
in a month to month service fee. So before
you say “No” or “Yes” to that next IT project,
make sure you are taking into consideration
the TOTAL cost of your decision, and make
sure you are talking to a true pro who
understands the difference between the price
of something and the total cost.

The right way to look at the true price of any
IT project or upgrade is to look at TCO or
“total cost of ownership” and not just the
PRICE of the project or upgrade. For example,
if you buy a car, the price of the car is only one
cost of owning it. You also have to consider
insurance, gas and routine maintenance like

- Bryan Lachapelle

Computer Problems?
We Will Fix Them For

If you are the owner of a small business
with 5 or more computers, I'd like to give
you a special "get to know us" offer and
make your first 2 hour service call
absolutely FREE. Why am I willing to
do this? Because I know once you see
how well we resolve your computer
problems, you'll become a client for life!

Visit: www.b4networks.ca/2freehours
Or Call Us: 905-346-4966
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5 Easy Ways To Spring Clean Your
Computer For Maximum Performance

The Lighter Side

With Spring in the air, now is a good time to do an annual clean up of the computers,
servers and electronic equipment in your office, both inside and out. Failure to thoroughly clean
your computers and servers at least once or twice a year will result in decreased performance
and possibly even system failures.

April Showers
Bring…Laughter!

Here’s why:
Dust clogs the computer’s cooling system
causing it to heat up, damaging sensitive electronic
equipment. Dust can also cause fan noise and
(believe it or not) slow performance!
Crumbs and dirt in your keyboard can cause
keys to stick and crunchy sounds when typing. Plus,
it’s just gross and unhealthy; do you know there are
more germs on your computer keyboard than the
average public toilet? Even dust, fingerprints and dirt
build-up will make your computer monitor dim and
fuzzy.
We covered how to physically clean your
computer in our February issue a few months ago, but...

The physical “dirt” is only the beginning...
Here are 5 quick steps you can take today to clean up your systems and improve
performance:

1. Use Disk Cleanup to delete temporary files, unused programs and any other files taking up
space and slowing things down. (Start > All Programs > Accessories > System Tools >
Disk Cleanup)

2. Defrag your hard drive to speed up access to your data. (Start > Control Panel > System
and Security > Administrative Tools > Defragment your hard drive).

3. Update your spyware and antivirus software with the newest definitions. The internet
changes fast. Having outdated security can slow you down dramatically.

4. Make sure you have the latest security patches and updates installed and configured
properly.

5. Check your backups and conduct an emergency “restore” of the data. Remember, the best

Q. What season is it when you
are on a trampoline?
A. Spring-time!
Q. When do monkeys fall from
the sky?
A. During Ape-ril showers!
Q. Can February March?
A. No, but April May!
Q. What flowers grow on faces?
A. Tulips (Two-lips)!
Q. Why is the letter A like a
flower?
A. A bee (B) comes after it!!
Q. What's the best day for
monkey business?
A. The first of Ape-ril!

time to check your backups is when you DON’T desperately need to recover your data!
Want Us To Spring Clean Your Computer Network? Call Us For Any Service
Between Now And April 30th And Receive...

10% off any service, repair or upgrade.
A FREE 27 Point Spring Network Tune-Up.

Add Any Folder to Favorites
You can add any library or folder to the
Favorites section in Windows Explorer. To add a
folder, navigate to it in Explorer, rightclick Favorites in the left navigation pane, and
select Add current location to Favorites. Now
you get quick access to your favorite folders in

Q. Do you know all about April
1st?
A. Yes, I'm fooly aware of it!

Q. Why is everyone so tired on
April 1?
A. Because they've just finished
a long, 31 day March!
Knock, knock!
Who's there?
Noah.
Noah who?
Noah body . . . April Fool's!

all File->Save As dialogs!

Need Help Right Away? Call our team 24/7 at 905.346.4966.
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Microsoft announced earlier this year
that they are going to place all of their
Microsoft Office desktop and cloudbased Office 365 software applications
under one umbrella in a renewed effort to
push their cloud-based subscription
model.
Microsoft will still sell their existing
desktop versions, but these will not be as
“fully featured” as the upcoming cloudbased versions (note that any Microsoft
software that ends in 365 is their cloud
based software). It’s becoming very
apparent that whether you’re a home
user or a large company, Microsoft wants
you to buy the cloud version of their
products going forward. If you don’t want
the cloud version on a monthly
subscription, you’ll have to settle for a
dumbed down version of the product
instead.
Here’s what this potentially means for
you:


The new “Office” family covers all
different editions of Microsoft Office,
from Student and Home Editions to

the most powerful tools that
Microsoft offers.


You will never have to worry about
buying CALs for Office 365.



You will now be able to shift your
budget dollars from one time or
annual license purchases to an
ongoing monthly operating expense,
thus evening out cash flow.



Things should be getting easier for
you to manage. Whether you are
starting from scratch or updating
software licenses for your office,
you’ll be able to get everyone
running on Office, Exchange,
Sharepoint, Lync, Word, Excel and
even Skype under one single
license.



Microsoft is also preparing a halfdozen bundles for Office and Office
365, many aimed at small business.

If you would like more information on
Office 365, please contact us and speak
with Bryan. 905.346.4966

Client Of The Month
The design/build process for any outdoor
project can be daunting task for anybody.
The team at Tree Amigos takes great pride
in making this process worry-free and
even enjoyable. I know this
from personal experience as
Tree Amigos is not just a B4
Networks client, I’m also a
client of theirs.

Last year I had Tree Amigos
come to my home to make a
proposal for landscaping our
front yard and an interlocking
brick walkway to the front
and side door of our home. Drew made
the entire process extremely fun and
easy. He came to our home, to get a

general idea of what my wife and I
wanted, and then made the whole thing
come to life with an beautiful and very
detailed proposal.
After accepting the proposal,
Drew and his team came by
and within a week, the entire
project was completed exactly
as detailed in the proposal, and
right on budget.
If your looking for a high
quality landscaping company
to do install your next outdoor
project, then I strongly suggest you
contact the Tree Amigos team.
www.treeamigoslandscaping.com

B4 Networks was instrumental in helping Tree Amigos with their office move a few years ago
and streamlined their IT by installing a new server, and 4 new laptops /desktops. Recently
we’ve helped them migrate to Office 365 to not only allow them to synchronize email on
their workstations, and their mobile phones, but also standardize on Office 2013 with little up
front investment.
We can help you too! Contact Bryan via email: bryan@b4networks.ca, or call 905.346.4966

A Quality Referral Is Music
To Our Ears…A FREE iPod
Is Music To Yours!
(See Below For Details On How The
Two Are Related.)

We love all our currently client, and
quite honestly, wish we had more like
you! So instead of just wishing, we’ve
decided to hold a special “refer-afriend” contest for the months of April
& May.
Even if your referral doesn’t hire us,
they’ll benefit from having a thirdparty conduct a FREE security audit of
their systems. Normally we charge
over $300 for this service, but we’ll
give it to them free since you referred
them.
All you have to do now is go online
to: www.b4networks.ca/referral
and give us the name of one or more
fellow business owners you know who
might benefit from our services.
There’s no obligation for them to buy
anything. We’ll award a brand new
iPod Touch to the customer who
refers us the most quality contacts
(see link above for details). We’ll also
give you a special gift, just for
referring your friends to us (for referrals
of businesses with 5 or more computers)

If you have any questions about our
contest, you can also call me direct at
905-349-4966 or simply e-mail me at
bryan@b4networks.ca with the name
and contact information of one of
your business colleagues who might
benefit from hearing from us.

Need Help Right Away? Call our team 24/7 at 905.346.4966.
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This months winner will receive a
$50 Gift Card to Canadian Tire
Enter our monthly trivia contest for a chance
to win a prize each month.
Congratulations to February's Winner:
Jessica Danyluk
From:
Goldhawk Accounting
To enter, visit the website below or email me:
bryan@b4networks.ca and answer the question below.

www.b4networks.ca/trivia
April is named after the Greek goddess,
Aphrodite. She is the goddess of:
a.
b.
c.
d.

Fire
Light
Love
Spring

Submit your entry by the 25th of the month, and if
your answers are correct, your name will be added
to the draw for a $50 Gift Card.
*See website for full trivia rules

I have to say that as a father, I have been extremely blessed to have two
wonderful, happy, and very fun to be with boys. On the left is a picture of my
son Aiden, who is just about always smiling. Taken by the very talented
Precious Laplante. On the right is a photo of Nate dancing at my brother’s
recent wedding. Nate loves to dance, and anytime dancing music comes on, he
will start doing some very funy dances, and even tries to “Break Dance” by
putting his hands on the ground and going in circles.

With Stick-N-Find, never lose your keys again, find your remote control, track your luggage or keep a virtual leash on your pet
fluffy so that you get notified when they go too far away.
About the size of a quarter and 0.16 inches thin, you can stick these just about anywhere! Stick them to any
device, person or animal and find them with your smartphone.
With an Apple iOS or Android app, you can view your misplaced items on a radar screen and decide if you
would like to have it buzz, flash or do both. Or create a “virtual leash” with the sticker – if that sticker moves
away more than a selected distance, your phone will alarm you. Lastly, “Find It” alerts allow you to be
alerted when your lost item comes in range of your phone.

Stick-N-Find Stickers have a Range of about 100 feet with a battery that lasts for over a year.
Find out more at www.sticknfind.com.








General Computer / Network Repair
and Troubleshooting
Network Design & Implementation
Backup and Business Continuity
Solutions
Anti Spam & Email Solutions
Virus and Spyware Protection
Network Security / Firewall Solutions









Commercial Wireless Networking
Fixed Cost Monthly Managed Services
Remote Monitoring and Diagnostics,
Troubleshooting and Repair
Project Management
Technology Consulting
Hosted Exchange Service
Cloud Services

706 East Main St
Welland, Ontario, L3B 3Y4
905.346.4966

www.b4networks.ca
We Make Technology Work!
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Meet The B4 Networks Team
Over the past 8 months we have welcomed quite a few new faces to the B4 Networks Team, and it’s very possible that some of you
have not had the opportunity to meet some members of our staff. Each of our team members are great customer ambassadors for
B4 Networks, and thrive on helping our clients with all aspects of their computers and technology. I present to you the B4 Networks team. For a full bio on each visit our website: www.b4networks.ca/about-us/staff/

Bryan Lachapelle
President

Heather King
Office Manager

Adam Brown
Senior Network Analyst

Derrick Thornbury
Network and IT Specialist

This is me, I started B4 Networks back
in 2004 (under a different name then),
however the reasons for starting the
company hold true to this day. I
believe every business has the right
to have an IT consultant that is
Reliable, honest, competent,
responsive, and fairly priced. I think
we’ve achieved that and more with
this team.

Heather has been part of the team
since 2009. She is the first point of
contact for our clients, and helps
connect them with one of our
growing support team members.
Having graduated from the Dental
Office Administration program at
Niagara College, Heather brings lots of
knowledge and experience to our
team, and we’d be lost without her.

Adam has been with us since the
start. Back in 2006 it was just me
and Adam, and together we’ve built
B4 Networks to what it is today.
Adam is our most senior consultant
and currently works mostly on large
complex projects including
networking, server deployments, and
maintaining systems for our
manufacturing clients.

Derrick is the most recent member to
join our team having started just a
few weeks ago. He comes to us with
a wealth of experience and
knowledge with having spent over 10
working in the IT sector. His good
sense of humor, and friendliness is
sure to be a great fit for our
company, and our clients.

Amanda Lachapelle
HR Manager

You won’t find Amanda at the office
often, as she also runs a very
successful Photography business.
(www.amandalachapelle.ca) But she is
responsible for helping me put
together the team you’ll see below, as
well as assist with the development of
policies and best practices. Amanda
also helps with Marketing, and putting
together this Newsletter.

Steve just started out with us in
December 2012, and already he’s an
integral part of our team. Steve is
responsible for coordinating all the
service requests that come through
email, phone, and any other avenue.
He’s the first person you should call
when you need any type of service.

Steve Lamarre
Service Coordinator

Mike Elia
Support Technician

Larry Lemelin
Public Relations and
Marketing

Mike started with us in September of
2012. He’s extremely skilled and has
many certifications behind him. Mike
primarily works at our help desk
performing many remote service calls,
and also installs the majority of our
client’s new desktop deployments.
One of Mike’s strong points is that has
a knack at explaining things in easy to
understand terms.
If you see Larry around, it will most
likely be while he is out at networking
events and promoting B4 Networks
through his many contacts. Larry’s
responsibility is to educate the public
about the company and look for great
companies that may need the services
of B4 Networks. He is very
approachable and loves to meet new
people and comes to us with lots of
experience having run his own
successful Limo company.

Need Help Right Away? Call our team 24/7 at 905.346.4966.

